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Introduction

Comprehensive CDMA Tools

The enormous growth of cellular telephone service has precipitated issues of spectrum capacity. This 
has resulted in a battle between digital proponents for both TDMA and CDMA formats. One of the potential 
advantages of Code Division Multiple Access (CDMA) is greater capacity.  Unfortunately, it is also the most 
difficult attribute to optimize if the system parameters and configuration are not correctly implemented.  "Pilot 
pollution", caused by excessive overlap of coverage contours, can rob CDMA designs of capacity.  From a 
practical point of view, placement of the base stations is dependent on tower space availability, and particularly 
at high PCS frequencies, very terrain dependent. With CDMA modulation, many RF carriers share the 
channel, and digital codes are used to separate the voices. Sometimes, too many codes radiate in one area or 
sector of a cell and cause interference because it reduces the ratio of signal to noise ratio, often referred to as 
Ec/lo (energy in a correlated bit to that of total RF channel energy). CDMA designers have designed a 
sophisticated system of power control into each mobile telephone to minimize such interference. But 
controlling the power from each mobile so they look the same when they are received at the base station is no 
simple trick. Just a 3 dB difference between one RF carrier and another (as received at the base station) 
reduces the system capacity by one-half!

Propagation Analysis of CDMA Signals

Modulated signals sharing the same RF channel have unique characteristics when signal reflections are 
encountered.  These reflections cause unphased additions of data symbols which can cause bit errors. 
Unmodulated signal strength measurements (using narrow bandwidth stimulus signals such as CW) are often 
misleading because the carrier strength of the signal appears to be strong, but there is often poor BER (Bit 
Error Rate) performance. The reason for this poor coverage is likely multipath reflections, better known as 
time dispersion of the RF carrier. Time dispersion or delay spreading is induced by reception of two or more 
signals of the same origin, with some components arriving later because they traveled a longer path; causing 
reflections and scattering of the signal. These distortions must be considered when planning and optimizing 
high-rate digitally-modulated radio systems.

The rational for advanced measurement tools

In almost all cases, short-term fading is caused by the environment, where two or more copies of the 
originally authored signal arrive at the receiver, but at different times.  These radio waves are then known as 
multipath waves, and when they combine at the antenna, vary widely in both phase and amplitude.  There are 
generally three properties that affect the character of the RF waves that arrive at the antenna.  They are 
distance, propagation time and bandwidth of the transmitted signal.  The signal strength has been the most 
traditional measurement for quality of the link.  In an ideal environment, it has a predictable relationship to 
distance, and has been used to determine overall coverage in analog communication system designs.

The adverse effects of multipath reception are:

(i) rapid variations in the received RF amplitude

(ii) some FM of the original signal caused by the Doppler shifts on more than one path

(iii) echoes (time dispersion) causing the carriers to add and subtract (vectorial in amplitude and phase) 
from each other causing data symbols to cancel
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Introduction to the Falcon PN Pilot Scanner

The Falcon is a pilot scanner that measures pilot signals in the selected RF channel and graphically 
presents the magnitude in Ec/Io or Ec. The receiver can be used for propagation study and site selection (with 
a Crocodile PN transmitter) through site verification and maintenance.

The reference frequency for the Synthesizer and 70 MHz PLLs is generated by the Genlock circuitry 
that is described in a following section.  The Genlock trains its Voltage Controlled Temperature Compensated 
Crystal Oscillator (VCTCXO) with the GPS PPS to provide a precision reference frequency for both the RF 
and digital sections of the system.

The received spread signal is down converted to an intermediate frequency (70 MHz IF).  An AGC 
system maximizes the dynamic range of the receiver during pilot analysis.  The output of the IF amplifier goes 
to an I/Q demodulator.  The output of the I/Q demodulator is sampled with a pair of A/D converters running at 
twice the chip rate (1.2288 MegaChips/second X 2).  

The digital correlators are implemented in the DSP as matched filter type.  The digital correlators 
correlate a 1024-bit section of the I pilot code and a 1024 bit section of the Q pilot code against the 
demodulated stream.  The correlation algorithm is depicted in the following figure.  The demodulated streams 
are snapped at the beginning of a frame.  The PN code used for correlation is then shifted after each correlation 
to scan pilots from different Base Stations or multipath. The Falcon can detect pilot signals with Ec/Io down to 
-20 dB.

Falcon Block Diagram
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Falcon Correlation Block Diagram

A GPS receiver may not be practical for a subscriber unit, but is very useful for a test instrument.  The 
Falcon receiver's code generator can be started at the GPS' even second pulse tick. If propagation delays are 
neglected, a transmitted signal with a PN offset of zero will be received by the receiver co-incident with the 
GPS' even second tick.  All pilots signals measured are recorded with a PN Offset calculated from the 
receiver's PPS, and are binned into the corresponding BS.  
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Falcon PN Offset Diagram

The GPS is also used to generate a precision time base for the Falcon receiver. The reference 
VCTCXO oscillator is phase locked to the PPS. Importantly, the code generators and chip rates of the 
transmitter and receiver are phase locked to a standard reference, the PPS.  The frequency of the PPS is too 
low to be used in a conventional phase lock loop circuit.  Instead, the PPS is used to estimate the frequency of 
the reference oscillator during each second.  The processor reads the number of pulses accumulated in the 
counter, CNT, during a second, compares this number with the expected count and increases or decreases the 
frequency of the VCTCXO.  This servo-system regulates the chip frequency in the transmitter and receiver for 
changes in temperature and inaccuracy of the oscillators.  The measured accuracy of the oscillators was 
improved from 2.5 part per million to 25 part per billion.  A second counter is used to accumulate any 
difference between the PPS and the code generator's clock.  The algorithm attempts to keep this counter equal 
to zero for perfect phase locking.

Lab testing verifies that the system can phase lock a receiver with a jitter of about 1/4 chip at a chip rate 
of 1.2288 MHz. 

Falcon GenLock Block Diagram
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The Power Delay Profile

When a component of the received signal is aligned in phase with the receiver's code generator, it will 
correlate and its magnitude is recorded.  This waveform of correlated energy versus time graphically displays 
the different multipath components within the system and channel and is defined as the Power Delay Profile.  
Different paths from the same pilot transmitter or paths from neighboring pilot transmitters with different time 
offsets will correlate at different times and be displayed.  This Power Delay Profile should be of primary 
interest to the CDMA system planner. 
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Falconeye (v1.1)

Software Operations Manual

Introduction
Falconeye is the application software which controls the operation of the Falcon CDMA Pilot Scanner. It is 
designed to display real-time information regarding CDMA Base Stations during drive studies. It is also 
designed to log pertinent information from these drive studies to be post-processed later for network 
optimization.

The real-time displays are helpful in recognizing problems as they appear for on the fly changes to the 
network.

The ASCII exported data from Falconeye can be imported into many post-processing and mapping products 
such as MapInfo and Maptitude. 

Application Overview
The Falconeye application consists of many screens and features controlled from a series of main screen 
components. The main screen consists of a menu, a top control panel, a left-side control panel, and a status 
bar.

The application starts by asking the user to which serial port the Falcon is connected. If AUTOMATIC is 
selected, then Falconeye will attempt to locate the Falcon itself. The Port Option screen can be brought up at 
any time by selecting it from the Communication menu item.

The main menu contains of five separate submenus. The first submenu is the File submenu. Various file 
manipulation features are in this submenu. The most used feature in this menu will be the Export option, 
which will be discussed later in this manual. The second submenu is the Edit submenu. This can be used for 
cutting and pasting entry field information. The third submenu is Options. Various Top Base Station options 
can be selected by choosing Top Base Stations. The warning beep which alerts the user of a non-lock status 
can be toggled on or off. Finally, the Sync Reset Delay can be altered. This feature will discussed later in the 
manual.

The next communications submenu allows port settings to be changed. The final submenu is Help. It contains 
options for on-line help and the About box.

The top control panel contains data logging options and statuses as well as screen selections. Any Falconeye 
screen can be selected by checking the box next to the screen name. The screens which are checked will be 
tiled in the viewing area. Data logging can be enabled or disabled by choosing from the combination box next 
to the words Pilot Data Capture. The base name of the log files can be selected in the field to the right by 
directly typing in the name of the file or by choosing the Browse button in order to append to an existing file.

The log filename extension will be chosen depending on the data being logged. See the individual scanning 
sections for the actual filename used for logging. The current status of logging will be displayed on the right of 
the top control panel. If any of the three screens are being logged (All Stations, Zoom #1, and Zoom #2), the 
word RECORDING will flash. Otherwise it will read DISABLED.

The side control panel passes parameters to and from the Falcon unit. If the GPS screens are in focus, (the 
selected screen) extra information will be displayed in this panel. When the RSSI screen is focused, 
parameters for its operation will be displayed.

NOTE: Never attempt to run RSSI and any other type of scanning at the same time. The RSSI scan changes 
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the frequency of the unit, invalidating any other scan output.

The side control panels background color will change depending on the lock status of the unit. If all three 
locks are achieved, the panel will turn teal. Otherwise, the panel will be red.

The status bar at the bottom of the screen contains various different statuses. The first two boxes display the 
current latitude and longitude of the Falcon. The next three boxes display the lock status of the unit. If the lock 
status for GPS, Gen Lock, or Sync have been achieved, the individual box will turn teal. In addition, if the 
GPS receiver is tracking at least 1 satellite, this box will turn yellow. The numbers in parenthesis in the GPS 
box indicate number of satellites (visible) and (tracked). The GPS receiver needs at least 3 satellites before 
achieving position lock.

The sixth box displays an antenna with a red circle and slash if the GPS antenna is not connected to the unit. 
The seventh box displays the serial port connected to and the frequency range of the unit.

The following paragraphs describes each of the scanning features in greater detail.

FalconEye Software displaying the basestation

Base Station Scanning
The Base Station scanning screen shows (in dBm) the top Base Stations at the set frequency. It displays Ec/Io 
values from 0 dB to 20 dB and shows True Power values on the right side. Underneath every visible Base 
Station is the Base Station number followed by chip offset in the Base Station.

Scanning begins by pressing the Start button in the Base Station Scan group of the side control panel. This 
button displays stop and can be used to stop scanning. The Reuse factor can be set so that only certain 
intervals of Base Stations are scanned. For instance, if the Reuse factor is set to 4, only Stations 
0,4,8,12,16,20, etc will be searched.
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If logging is turned on, data will be placed into a file using the filename supplied in the top control panel plus 
the extension .BAS. Contents of this file will be displayed later in this manual.

FalconEye Software with 2 base station zooms

Single Base Station Scanning
The Single Base Station scanning screen shows all 64 chips of the selected Base Station at the set frequency. It 
displays Ec/Io values from 0 dB to 20 dB and shows True Power values on the right side in dBm. 

Scanning may be started by pressing the Start button in the Base Station Zoom(s) group of the side control 
panel. This button will then display Stop and can be used to stop scanning. The Station to be scanned can be 
selected by either entering the Base Station number into the entry field provided or by clicking on the desired 
Base Station on the Base Station screen. Using the left mouse button will select the closest peak into Zoom#1. 
Using the right mouse button will select the closest peak into Zoom#2.

NOTE: Do not attempt to log data when both Zoom screens are set to the same Base Station. Logging results 
will become unpredictable.

If logging is turned on, data will be placed into a file using the filename supplied in the top control panel plus 
the extension .###, where ### is the Base Station number being scanned. Contents of this file will be 
displayed later in this manual.
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FalconEye top base stations screen

Top Base Station Display
The Top Base Station screen displays bar charts of the Top 6 Base Stations and their Ec/Io values. The bottom 
legend displays the actual Base Station numbers. The TAdd and TDrop lines are configurable in the Top Base 
Station options screen in the Options submenu. Bars above and below these lines have different colors. The 
order of the bars can also be configured by choosing the Top Base Station options. The bars can be ordered by 
Ec/Io, Base Station number, or fixed. Fixed means that once a Base Station shows up on this screen, it will 
stay in the same slot.

Top Base Station data is logged under the same file as the Base Station data.

RSSI Sweep
The RSSI display shows the RSSI power over the frequency range selected. The scan is controlled by use of 
the Start button. Parameters such as center frequency, span, base amplitude, and resolution bandwidth can be 
configured.

No RSSI data is available for logging.

NOTE: Never run RSSI scans in parallel with any other scanning. Always stop the other scan before 
attempting to start an RSSI scan.
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FalconEye GPS tracking information screen

GPS Tracking Information
The GPS Tracking Information screen shows the drive path being taken by the user. It is graphed in decimal 
degrees against latitude and longitude.

In addition, the current GPS recognized position and heading are displayed in the left control panel.
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FalconEye GPS information screen

GPS Satellite Information
The GPS Satellite Information screen displays various information on up to eight satellites being tracked. In 
addition, the current GPS recognized position and heading are displayed in the left control panel.

GPS Reset Delay
There may be cases where GPS lock is lost for short periods of time. This can happen whenever the user 
drives under overpasses or between tall buildings. To prevent the synchronization hardware from resetting 
upon GPS loss, a configurable delay may be set using the Sync Reset Delay option under the Options 
submenu. This is defaulted to 30 seconds. Sync and Gen lock will not be reset until after GPS information has 
been lost for more than this delay period.

Exporting Data
Data may be exported into an ASCII format (described below) by choosing the Export option from the File 
submenu. The top filename is the binary file from which the user wishes to export the data. If the file is a 
general Base Station file, make sure to add the .BAS extension. If it is a zoom file, make sure to add the 
extension using the Base Station number. For instance, if the base filename was Drive1, and the Base Station 
logged was 28, then the file would be Drive1.28.

Next enter the filename to receive the ASCII output. Click on Export Now to begin converting the data. A 
progress bar is provided on the bottom of the export screen to monitor its progress. 

ASCII File Format
The ASCII data is comma delimited and each record ends with a carriage return/line feed combination. Latitude 
and longitude are provided first for easy import into mapping software.
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Base Station Data
Lat,Lon,Date,Time,Frequency,Reuse Factor, Status, BS#,Ec/IO,Power, BS#,Ec/Io,Power<CR/LF>

Where,
Lat is the latitude in decimal degrees.
Lon is the longitude in decimal degrees.
Date is in MM/DD/YY.
Time is in HH:MM:SS.FFFFFF where FFFFFF are fractional seconds.
Frequency is the frequency of the unit in MHz.
Reuse Factor is the Reuse Factor.
Status is the lock status where bit0 is the GPS lock status, bit 1 Gen lock, and bit2 is Sync. 

Therefore, with all 3 locks, the status would be 07.
BS# is the Base Station number.
Ec/Io is the Ec/Io ratio in dB.
Power is the True Power in dBm.

Zoom Station Data
Lat,Lon,Date,Time,Frequency,Reuse Factor, Status, Ec/Io(0),Power(0), Ec/Io(63),Power(63)<CR/LF>

Lat is the latitude in decimal degrees.
Lon is the longitude in decimal degrees.
Date is in MM/DD/YY.
Time is in HH:MM:SS.FFFFFF where FFFFFF are fractional seconds.
Frequency is the frequency of the unit in MHz.
Reuse Factor is the Reuse Factor.
Status is the lock status where bit0 is the GPS lock status, bit 1 Gen lock, and bit2 is Sync. 

Therefore, with all 3 locks, the status would be 07.
BS# is the Base Station number.
Ec/Io is the Ec/Io ratio in dB.
Power is the True Power in dBm.
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Falcon Cabling Diagrams
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Falcon Rear Panel Diagram
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Falcon Case Diagram
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SPECIFICATIONS for laptop PC for Falcon

     CPU, Memory, and Architecture:

          Intel Pentium(r) processor: 233MHz MMX or 166MHz. Supplies correct dual voltages for MMX 
processors. 128MB maximum EDO RAM. PCI Bus architecture. 256K Level 2 Synchronous Pipelined burst-
mode Cache.

     Display:

          12.1" 800 x 600 Dual-Scan Passive (256 color) or TFT Active Matrix Color display supporting 
480,000 simultaneous colors from a 16 million color pallet. Trident video chip features 2MB EDO 
display  memory, acceleration, and a 64-bit PCI Bus interface, and supports simultaneous display on 
LCD (internal) and external VGA or NTSC/PAL monitor or TV/VCR. Up to 1280 x 1024 resolution in 256 
colors when used with external monitor. Internal MPEG available.

     Input Devices:

          PS/2 Glidepad (centered under keyboard). 86-key detachable Win95 keyboard with A4 size keys 
and an embedded numeric keypad.

     Ports:

          1 DB9 serial (high-speed 16550 UART) and 1 parallel (EPP/ECP) port. External VGA, microphone, 
speaker, keyboard/mouse (ps/2), game/MIDI, and infrared file transfer (IrDA / FIR compliant) ports.

     Integrated Multimedia:

          Built-in CD-ROM Drive, using an IDE interface for best compatibility. Internal 16-bit Soundblaster 
Pro 3.01 compatible sound card with 1MB ROM wavetable for high quality sounds. Built-in mic and 
stereo speakers.

     PCMCIA:

          Two stacked PCMCIA type II expansion slots (these also accept one type III card in the place of 2 
type II cards).

          PLUS one additional, separate type II only slot with support for Zoomed Video (a direct bus to the 
video display).

     Physical:

          11.8" x 8.9" x 2". Weighs 7.5 lbs. with one battery and floppy in place.

     Power:

          110V - 240V, 47-63hz auto-sensing external AC adapter. Built-in Intelligent Power Management 
(IPM) hardware. Removable lithium ion battery. Primary battery alone lasts 1 to 1.3 hours depending on 
use. Primary and secondary battery used together last 2 to 2.6 hours depending on use. (Suspend 
feature further extends battery life when system is idle). Suspend to hard disk feature saves all memory 
to the hard drive before a low battery condition shutdown occurs.
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Removable drives:

          1.3GB (13ms) or 2.1GB (12ms) hard drive options. Enhanced PCI IDE hard disk interface supports 
PIO mode 3 operation. 3.5" 1.44MB Floppy Diskette Drive (removes for insertion of second battery).

          110 Watt internal power supply, accepts 100-240V AC power in. One 5.25" and one 3/5" drive bay 
(SCSI devices recommended). One special bay accepts the 6200/mint floppy drive. Three PCI slots 
accept two-thirds height PCI cards. One parallel port, two serial ports, one 15-pin VGA/SVGA port, one 
external ps/2 keyboard/mouse port, headphone jack, TV out RCA jack, one game/midi port. Two 
internal speakers. Dimensions: 381mm x 405.5mm x 113mm. Weight: 2.5kg (5.5lbs).
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Glossary of Acronyms

AC Alternating Current
A/D Analog to Digital converter
AGC Automatic Gain Control
BER Bit Error Rate
BPSK Binary Phase Shift Keying
BW Band Width
CDMA Code Division Multiple Access (spread spectrum modulation)
DC Direct Current
D/A Digital to Analog
dB decibel
dBm decibels referenced to 1 milliwatt
DOS Digital Operating System
DSP Digital Signal Processing
FIR Finite Impulse Response
GHz GigaHertz
GPS Global Positioning System (satellite based)
GPS diff. GPS error correction signal which enhances GPS accuracy
IF intermediate frequency
I and Q In phase and Quadrature
kHz kiloHertz
LCD Liquid Crystal Display
LO Local Oscillator
Mbits Megabits
MHz MegaHertz
modem acronym for modulator/demodulator
PCMCIA Personal Computer Memory Card International Association
PC Personal Computer
PCS Personal Communications Service (1.8 to 2.1 GHz)
PN Pseudo Noise
QPSK Quaternary Phase Shift Keying, 4-level PSK
RF Radio Frequency
RSSI Receiver Signal Strength Indicator
UCT Universal Coordinated Time
VAC Volts Alternating Current
VGA video graphic  
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Technical Support
• Up-to-date information is available on our web site at http://www.bvsystems.com
• The latest version of Falconeye is also available on our web site for download.
• If you wish to contact technical support, e-mail to info@bvsystems.com

Acknowledgements
• Microsoft is a U.S. registered trademark of Microsoft Corporation.
• Windows is a trademark of Microsoft Corporation.

Notice
Information in this document is subject to change without notice.

No part of this document may be photocopied, reproduced, or translated into another language without the 
prior written consent of Berkeley Varitronics Systems, Inc.

Berkeley Varitronics Systems, Inc. disclaims all warranties, either express or implied, including but not 
limited to implied warranties of merchantability and fitness for a particular purpose, with respect to the 
instructions contained in this manual.

@1998 Berkeley Varitronics Systems, Inc. All Rights Reserved.
Printed in the United States of America
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If you require technical assistance, or service to your Falcon PN Scanner, contact:

         Falcon Technical Support           
Liberty Corporate Park 

Berkeley Varitronics Systems, Inc.
255 Liberty Street

Metuchen, NJ 08840
Tel: (732) 548-3737
Fax: (732) 548-3404

8:00am - 6:00pm Eastern Time
www.bvsystems.com   E-mail: info@bvsystems.com
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